State of California – Government Operations Agency
California Complete Count-Census 2020
400 R Street, Suite 359
Sacramento, CA 95811
www.census.ca.gov
(916) 852-2020

GAVIN NEWSOM, Governor
DITAS KATAGUE, Director

FINAL REPORT
General Information
Date of report

10/22/2020

Organization / Entity
Responsible Person /
Title
Contact Person /
Title
Address
Email / Phone

County of San Luis Obispo
Wade Horton, County Administrative Officer
Kristin Eriksson, Administrative Analyst
1055 Monterey St., Room 430D, San Luis Obispo, CA 93408
keriksson@co.slo.ca.us; 805-781-5014

Narrative Report
1) List your goal(s) and objectives as it appears in your strategic and implementation
plan. What and how did you revise the objectives due to COVID-19 and the US
Census Bureau’s operational adjustments?
Implementation Plan Objectives:
1. Contract with marketing firm to develop targeted, local census outreach
plan and materials;
2. Operate a Questionnaire Assistance Center and phone line in the Paso
Robles downtown corridor census tract;
3. Work with partners to distribute targeted information to hard to count (HTC)
populations
COVID-19/Operation Adjustment Revisions:
1. Verdin Marketing, Inc. was engaged for initial local census outreach and
Non-response Follow Up (NRFU) engagement. The digital marketing
campaign ran from March-April and from August-September. Additional
outreach materials, including updated tool kits for partners and promotional
reusable bags were designed.
2. The Questionnaire Assistance Center was closed at the start of Stay-at-Home
orders. As a result, the County instead operated a Questionnaire Assistance
phone line (QAP) during operational hours and after hours from 5-7 p.m. on
Wednesdays from April 6 through October 15, 2020. There were 693 total
contacts with County residents through the phone line.
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3. The County engaged Verdin Marketing to design and procure various
promotional and informational materials to create tool kits for partners to
assist with their engagement with HTC populations. The County also provided
tool kits for NRFU with updated messaging in light of the pandemic and U.S.
Census Bureau operational changes.
2) Reflecting on your own operations and outreach strategies throughout the
campaign, please provide a response with specific examples for the following
questions. Please also indicate which timeframe you are referring to in your response
(i.e., education, NRFU period).
Contracted partner’s operations
What worked well operationally?
Providing our partners with materials so that they were equipped to serve as trusted
messengers for the communities they regularly serve proved effective. The County’s
digital media campaign was successful in achieving 1.3 million impressions with
residents.
What hindered the operations?
The Stay-at-Home restrictions hampered the County’s plans for in-person outreach
initially. Additionally, it was difficult to find staffing for the QAC and QAP. Finally,
capturing public attention during an unprecedented time, including the COVID-19
pandemic, civil unrest, and a presidential campaign was difficult.
Contracted partner’s outreach
What outreach tactics worked well?
As noted above, our digital media campaign reached a large number of people,
including HTC residents. Additionally, the mailing of promotional post cards to the
HTC census tracts precipitated more engagement with the County’s QAP and
resulted in greater response.
What hindered the outreach?
The Stay-at-Home restrictions hampered the County’s plans for in-person outreach
initially. Additionally, it was difficult to find staffing for the QAC and QAP. Finally,
capturing public attention during an unprecedented time, including the COVID-19
pandemic, civil unrest, and a presidential campaign was difficult.
3) Describe challenges and changes occurring outside or within your organization /
agency that had an impact on the outreach work. Describe how you responded to
these changes to work toward achieving a complete count.
Given the limited funding for Census outreach the County received, we had to rely
on existing staff for outreach activities, rather than being able to hire dedicated staff
for the project. Additionally, the extension of the Census response deadline further
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taxed County resources. County staff worked with management to ensure
resources for outreach and operation of the QAP through October 15.
4) For county and ACBO partners, what was the county (or region’s) 2010 response
rate and what was the 2020 response rate? If the response rate met and exceeded
the 2010 response rate, what contributed to that? If it did not meet the 2010
response rate, what were some of the challenges for that? For other partners, please
note what data you used and how you used data for your strategies.
The County’s 2010 self-response rate was 66.3%. The self-response rate for the 2020
Census was 68.5%, exceeding the 2010 rate by 2.2%.
5) Please describe the process and results of your partnership coordination and how it
educated and motivated the hard-to-count populations to complete the Census
questionnaire.
The County worked closely with our partners (cities, local government agencies,
local community-based organizations (CBOs), etc.) closely in developing our
marketing campaign to ensure the messaging would effectively reach HTC
populations. Additionally, the County provided promotional and informational
materials to our community-based organizational partners to support their direct
outreach as trusted messengers to the HTC populations they regularly serve. All
materials were available in English and Spanish.
6) Please provide a list of key partners and describe their contributions of how they
made a difference in your outreach efforts.
1. Cities of Arroyo Grande, Atascadero, Grover Beach, Morro Bay, Paso Robles,
Pismo Beach and San Luis Obispo – all cities helped spread messaging
through their social media channels and collaborated in creating the digital
marketing campaign. The City of Paso Robles hosted the QAC while it was
operational and distributed promotional materials to residents through the
Paso Robles City Library.
2. CBOs, including Community Foundation of SLO County, Community Action
Partnership of SLO County (CAPSLO), First 5 SLO, Central Coast Commission
for Senior Citizens and People’s Self-help Housing – all worked with the Region
5 Administrative CBO on direct outreach to HTC populations and
collaborated with the County to develop the marketing campaign.
3. County Libraries – provided dedicated computers for Census responses;
distributed outreach materials and promotional items through operational
libraries throughout the county.
4. SLO Food Bank – distributed promotional materials and information through
food delivery/distributions countywide.
7) Please describe how you provided accessible and in-language outreach activities,
including how you ensured equal and meaningful access to limited English
proficient individuals and people with disabilities?
3
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The County’s QAP provided information and assistance in English and Spanish (the
most predominant first language besides English in the County). All informational
and promotional materials were created in English and Spanish and digital content
was also provided in Spanish countywide. The County worked with and provided
materials for CBO partners who provided outreach to limited English proficiency and
disabled residents.
8) Please share a story(s) of how your work has made a difference to Census 2020 and
the impact on the community. Please include images and quotes, so we are able
to understand the narrative behind the numbers.
The County’s dedicated QAP staff, Maria Brown takes great pride in knowing that
she provided information about the Census or direct assistance to respond to the
Census to nearly 700 County residents. Ms. Brown stated, “I felt I was able to help
people who were vulnerable. The elderly population are not familiar with
technology and are also afraid of in-person responses because they are afraid of
contracting COVID-19. And, many people who do not have legal status were
reluctant to participate in anything related to the government. I hope my work on
the phone line made these people feel better about responding to the Census.”
9) Please add any suggestions for the 2030 Census efforts, including timelines.
Should the State choose to fund similar efforts for the 2030 Census, it would be
helpful for earlier engagement with all counties, not just the larger counties.
Additionally, the State’s requirements of contracted partners and plans for the
State’s own outreach should be made clear at the outset. It was difficult to adjust
to changing and often unclear expectations and avoiding duplicative efforts was
equally challenging as the State’s plan was not clear in the beginning of our efforts.
It would also be beneficial to have closer coordination with the US Census Bureau to
be sure messages are in line with the Bureau’s efforts and to ensure continuity of
information that is provided to the public.

Attachments
10) Please confirm that you have submitted the following which will help us better
understand the full breadth of the Census work and achievements.
a) SwORD uploads of completed activities
** Completed by CA Complete Count office staff **
b) Updated list of subcontractors
** No attachment – Verdin Marketing, Inc. is our only subcontractor **
c) Evaluations or analytical reports, if any
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** Digital marketing data attached **
d) Sample products*
** Sample marketing materials attached **
* communication collaterals, including those in additional languages; toolkits;
newsletters; phone or radio scripts; guidelines; communication analytics; articles;
trainings; and other graphics (a digital copy is sufficient, the original copy is not
required)

Submission
Please submit your final report and attachments no later than November 16, 2020 to:
outreach@census.ca.gov with a copy to the RPM/contract manager. Please include
your organization name in the subject line.
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CAMPAIGN STAT SUMMARY
SLO COUNTY 2020 CENSUS PLAN
May 4, 2020
The following report covers the March and April campaign, encouraging locals to fill out their
census survey and to learn more if needed.
The campaign as designed was to utilize programmatic video, Facebook and Instagram. Due to
recently changes in algorithms and policy, Facebook and Instagram designated the Census
campaign as political content. Multiple manual review requests were entered, but ultimately
budget was moved from social advertising into programmatic advertising. The programmatic
advertising portion of the campaign was running well and reaching the intended targets.
The student persona was seriously affected most by the COVID-19 crisis. The anticipated amount
of students we hoped to reach during the planning phase was reduced as students returned
home for online classes and to adhere to shelter in place orders.
Generally the media plan came in under budget due to the reduced ability to reach targeted
locals on social media.

FACEBOOK
Impressions: 90,078

Link Clicks: 282

Total Clicks: 701

Total CTR: 0.8%

PROGRAMMATIC ADS
Students
Impressions: 216,995

Clicks: 784

CTR: 0.4%

Video Views to 100%: 108,260

Spanish Speakers
Impressions: 380,419

Clicks: 4,647

CTR: 1.3%

Video Views to 100%:

128,170

CTR: 0.3%

Video Views to 100%:

207,855

CTR: 0.7%

Video Views to 100%: 444,285

Underserved
Impressions: 461,804

Clicks: 1,224

TOTAL CAMPAIGN RESULTS
Impressions: 1,149,296

Clicks: 7,356

t (805) 541-9005 f (805) 541-9007
3580 Sacramento Drive #110, San Luis Obispo, CA 93401
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ADVERTISING REPORT
SLO COUNTY CENSUS
September 25, 2020
The non-response portion of the Census outreach campaign was initially scheduled to run from
Aug. 1 to Oct. 31. After national changes to the end date of the Census collection period, the
campaign end date was modified to Sept. 30. The campaign will be live until Sept. 30, however
for reporting purposes, the following numbers reflect the time period from Aug. 12 to Sept. 25.
Two tactics were designed to reach the hard-to-count population. One was created for
underserved residents in the more rural areas of the county, and another was made in Spanish
to reach Spanish speakers within the more agriculture-heavy portions of the county.
Both tactics performed as expected, with a slight decline in clicks as the months progressed. This
was anticipated as more and more individuals completed their Census survey, leaving fewer
people who needed information on signing up. Additionally, the video had a very good
completion rate (51%), which means although consumers may not have clicked to learn more,
they viewed the entire video message.
The non-response portion of the Census outreach campaign was served programmatically due to
the clutter and regulations of ‘social topics’ on Facebook and Instagram during this political
cycle.

PROGRAMMATIC VIDEO
Impressions: targeting hard-to-reach English and Spanish residents: 225,683
Clicks to website: 596
Click Through Rate: 0.3%
Views to 100% of Video: 115,002

t (805) 541-9005 f (805) 541-9007
3580 Sacramento Drive #110, San Luis Obispo, CA 93401
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SLO County Non-Response Media Plan

Run Dates: 8/1/20 - 10/31/20

Programmatic Video

Target Locations

Type of Targeting

Exact Geos

August

September

October

Underserved

Rural and low
Broadband tracks

English Speakers. 75K and
Under Household Income

Cambria, Cayucos, San Simeon,
Atascadero, Paso, Shandon 25+
miles all locations

$1,600

$1,700

$1,700

Spanish Families

High Spanish
Spanish Speakers, Geofenced
Speaking and
Agricultural tracks
Agricultural tracts

Arroyo Grande, Nipomo both
25+ miles, 93420, 93453,
93432

$1,600

$1,700

$1,700

$3,200

$3,400

$3,400

Monthly Totals

HELP OUR
COMMUNITY
RECOVER
Complete the 2020 Census
It takes less than 10 minutes to fll out and will
provide more funding for Central Coast
schools, hospitals, and businesses.

Visit slocountycensus.org
or call (805) 781.5011 for more info

AYUDE ANUESTRA
COMUNIDAD A
RECUPERARSE
Participe en el censo 2020
Le tomará menos de 10 minutos para contestar
todas las preguntas y esto ayudará y
proporcionará más fondos para las escuelas,
hospitales y empresas de la Costa Central.
Además, no hay preguntas sobre inmigración.

Visite slocountycensus.org o llame al
(805) 781.5011 para obtener más información

NOT FOR REPRODUCTION
This file is intended for design
presentation, visual review, and
proofreading purposes only and cannot
be used for reproduction in any manner
whatsoever. Digital files, appropriate
for high quality reproduction, will be
created and supplied after approval of
all visual and written elements related
to this project.

Please call (805) 541 - 9005
with any questions. Thank you!

How to add your logo to the Census poster
Option 1: Adobe Acrobat Pro
Open Adobe Acrobat Pro. Click on “Edit PDF”
In the latest version, it will be an icon of pink square / rectangle shapes.

On the top bar, click “Add Image” and select your logo file. We recommend using a PNG file
with a transparent background.

You will be able to drag the logo to the top right corner and resize by dragging the end points.

Option 2: Use a free online platform: photopea.com
Photopea is a free online platform similar to Photoshop. You will be able to open the .PSD file of
the poster (not the PDF).
On Photopea.com, click File -> Open… and select the CENSUS_PartnershipPoster.PSD
1. On the bottom right of your screen, you will see a panel that shows Layers.
2. Click on the right facing arrow next to “Logo” to show more layers. You will now see two
layers with a “T” in a white box
3. Press the “eye” icon next to each of the “T” layers. This will cause the icon to turn grey, which
hides the layer from view. You will no longer see the upper right corner text that says “Insert
logo here” and “Logo should be right aligned”
1.

2.

3.

Next, on the bottom right Layer panel, click on the icon in the red box to “add layer”
You will now see “Layer 1” at the top of the layers.

On the upper left corner, click File -> Open & Place. Select your logo file.
Click on the logo and drag it over to the right, and drag it near the cyan line. It will “snap” into
place and align.

In order to resize your logo if it is too large, while the logo is still selected, click Edit -> Free
Transform. Hold the SHIFT key down and drag one of the corner points inward to make the logo
smaller.
Once you are finished, save the file as a PSD file first. Then press File -> Export As -> PDF.
If you have any difficulty editing your poster file, please contact kailey@verdinmarketing.com

Location Name/Media Outlet Type

Address/Media Channel

Date(s)

Time(s)

HTC Focus

Spanish Speaking
Students
Students
Students

QAC
QAK
QAK
QAK

3201 Spring Street, Paso Robles
1 Grand Ave., San Luis Obispo
1 Grand Ave., San Luis Obispo
1 Grand Ave., San Luis Obispo

3/12-4/25/20
2/12/2020
3/10/2020
4/1/2020

Thursdays, 2-6PM
Fridays, 2-5PM
Saturdays, 9:30AM12:30PM
TBD
TBD
TBD

QAK

400 Oak Hill Rd., Paso Robles

4/22/2020

6-8PM

Spanish Speaking

QAK

2940 Spring St., Paso Robles

4/1/2020

2-4PM

Seniors/Disabled

QAK

150 S. Courtland St., Arroyo
Grande

3/25/2020

5-7PM

Other

QAK

351 S. Elm St., Arroyo Grande

3/25/2020

11AM-1PM

Seniors/Disabled

QAK

456 Elena St., Morro Bay

4/9/2020

10AM-12PM

Seniors/Disabled

QAK
Community
Meeting
Community
Meeting
Community
Meeting
Community
Meeting
Community
Meeting
Community
Meeting
Community
Meeting
Community
Meeting
Community
Meeting
Community
Meeting

2835 Schoolhouse Lane, Cambria 4/14/2020

6-8PM

Spanish Speaking

5905-C East Mall, Atascadero

TBD

TBD

Seniors/Disabled

2700 Eton Rd., Cambria

TBD

TBD

Seniors/Disabled

2180 Palisades Ave. Los Osos

TBD

TBD

Seniors/Disabled

1001 Kennedy Blvd., Morro Bay

TBD

TBD

Seniors/Disabled

200 E. Dana St., Nipono

TBD

TBD

Seniors/Disabled

1580 Railroad Ave., Oceano

TBD

TBD

Seniors/Disabled

270 Scott St., Paso Robles
955 Monterey St., San Luis
Obispo
11245 Los Osos Valley Rd., San
Luis Obispo

TBD

TBD

Seniors/Disabled

TBD

TBD

Seniors/Disabled

TBD

TBD

Seniors/Disabled

2210 "H" St., Santa Margarita

TBD

TBD

Seniors/Disabled

Creston Garden Apartments QAK

1255 Creston Road, Paso Robles

3/31/2020

6-8PM

Spanish Speaking

Templeton Place

QAC

1009 Petersen Ranch Road,
Templeton, CA

4/23/2020

Arroyo Grande Library

Other

800 W. Branch, Arroyo Grande

3/12-4/30

Atascadero Library

Other

6555 Capistrano, Atascadero

3/12-4/30

San Luis Obispo Library

Other

995 Palm St., SLO

3/12-4/30

Cambria Library

Other

1043 Main St., Cambria

3/12-4/30

Cayucos Library

Other

310 B St., Cayucos

3/12-4/30

Creston Library

Other

6290 Adams, Creston

3/12-4/30

Los Osos Library

Other

2075 Palisades, Los Osos

3/12-4/30

Morro Bay Library

Other

625 Harbor St., Morro Bay

3/12-4/30

Nipomo Library

Other

918 West Tefft, Nipomo

3/12-4/30

Oceano Library

Other

1551 17th St., Oceano

3/12-4/30

San Miguel Library

Other

3/12-4/30

Santa Margarita Library

Other

254 13th St., San Miguel
9630 Murphy Ave.,
Santa Margarita

3/12-4/30

Shandon Library

Other

240 E. Centre, Shandon

3/12-4/30

Shell Beach Library

Other

230 Leeward Ave., Shell Beach

3/12-4/30

2-4PM
Seniors/Disabled
10am-6pm M-Th
10am-5pm F-Sat.
Other
10am-6pm M-Th
10am-5pm F-Sat.
Other
10am-6pm M-Th
10am-5pm F-Sat.
12pm-4pm Sun
Other
9am-5pm Tues-Wed
10am-6pm Th 10am5pm F-Sat
Other
10am-6pm M-W 10am5pm F
Other
1pm-7pm Tues
12pm-6pm Thurs
10pm-4pm Fri
Other
10am-6pm Tues-Wed
10am-5pm Thurs-Sat
Other
10am-6pm Tues-Wed
10am-5pm Thur-Sat
Other
10am-6pm Tues-Thurs
10am-5pm Fri-Sat
Other
11am-6pm T-Th
11-5 Fri
Other
11am-5pm Wed 12pm6pm Thurs 10am-4pm
Sat
Other
12pm-6pm W-Th 10am5pm F-Sat
Other
11am-6pm T-Th 11am5pm F
Other
11am-5pm Tues
12pm - 6pm W
11am
- 5pm Fri
Other

Paso Robles Library
CA Polytechnic State Univ.
CA Polytechnic State Univ.
CA Polytechnic State Univ.
Canyon Creek Apartmetns
Los Robles Terrace (Senior &
Disabled)
Courtland Street Apartments

Cawleti (Senior Home)
Ocean View Manor (Senior
Home)
Schoolhouse Lane
Apartments
Atascadero Senior Center
St. Paul's Episcopal Church
South Bay Community
Center
Senior Citizen's Center
Senior Citizens Club
Central Coast Senior Center
Paso Robles Senior Activity
Center
Anderson Hotel

Santa Margarita Senior
Citizens Center

Est. Number of
Attendees

not sure; 68 - 2
and 3 bedroom
units
not sure; 40 studio and 1
bedroom units
not sure; 36 - 1,
2 and 3
bedroom units
not sure; 28 - 1
and 2 bedroom
units
not sure; 61 studio and 1
bedroom units
not sure; 24 - 2
and 3 bedroom
units

Organization

County of SLO
Cal Poly
Cal Poly
Cal Poly

People's Self-Help

People's Self-Help

People's Self-Help

People's Self-Help

People's Self-Help

People's Self-Help
Central Coast Comission for
Senior Citizens
Central Coast Comission for
Senior Citizens
Central Coast Comission for
Senior Citizens
Central Coast Comission for
Senior Citizens
Central Coast Comission for
Senior Citizens
Central Coast Comission for
Senior Citizens
Central Coast Comission for
Senior Citizens
Central Coast Comission for
Senior Citizens
Central Coast Comission for
Senior Citizens
Central Coast Comission for
Senior Citizens

not sure; 60 - 2
and 3 bedroom
units
People's Self-Help
not sure; 29 - 1
and 2 bedroom
units
People's Self-Help

Contact

Kristin Eriksson
805-781-50140
keriksson@co.slo.ca.us

Anna Vela
805-540-2487
annav@pshhc.org
Anna Vela
805-540-2487
annav@pshhc.org
Anna Vela
805-540-2487
annav@pshhc.org
Anna Vela
805-540-2487
annav@pshhc.org
Anna Vela
805-540-2487
annav@pshhc.org
Anna Vela
805-540-2487
annav@pshhc.org

SLO County Library

Anna Vela
805-540-2487
annav@pshhc.org
Anna Vela
805-540-2487
annav@pshhc.org
Sharon Coronado
805-781-4187
Sharon Coronado
805-781-4187

SLO County Library

Sharon Coronado
805-781-4187

SLO County Library

SLO County Library
SLO County Library

SLO County Library
SLO County Library
SLO County Library
SLO County Library
SLO County Library

Sharon Coronado
805-781-4187
Sharon Coronado
805-781-4187
Sharon Coronado
805-781-4187
Sharon Coronado
805-781-4187
Sharon Coronado
805-781-4187
Sharon Coronado
805-781-4187
Sharon Coronado
805-781-4187

SLO County Library

Sharon Coronado
805-781-4187
Sharon Coronado
805-781-4187
Sharon Coronado
805-781-4187

SLO County Library

Sharon Coronado
805-781-4187

SLO County Library
SLO County Library

QAC
QAK
Local Event
Community Meeting
Media
Other

Spanish Speaking
Students
Homeless
Seniors/Disabled
Other

QAC/QAK GUIDE

SIGNAGE

The following sign templates may be customized by Partners (in languages
supported) and printed by Partners to ensure community members visiting
QAC/QAK locations receive information regarding location, hours, assistance
available, and QAC/QAK guidelines tips.
The following signs will be provided in the 13 threshold languages at a later date.
Partners may translate in additional languages to meet the language and/or
accommodations (e.g., braille and large print) needs for community members
using your QAC/QAK location.

California Complete
Count
Outreach Partner
If you need accommodations or
in-language support, please see a
member of our team for
assistance.
If site is not staffed, please call the
U.S. Census Bureau at:
844-330-2020

California Complete
Count
Outreach Partner
Questionnaire Assistance Center/Kiosk Tips:
• Ensure your online responses are
Tip: Look for
entered at
“https” in the beginning
https://2020census.gov/.
of the website address
• Misuse of devices is not allowed.
and the image of a
• Report suspicious activity to
padlock to indicate this
QAC/QAK host or team member. is a secure website.
• Staff and volunteers are not
employees or representatives of
the U.S. Census Bureau.
• Staff and volunteers cannot assist you with completing
the Census Questionnaire*; however, they can answer
questions you may have regarding the Questionnaire.
*Assistance may be provided in very limited situations where the
individual is unable to complete without help

• Call the U.S. Census Bureau if you need additional
assistance at: 844-330-2020
• Close the browser once your response is complete.

California Complete
Count
Outreach Partner
Questionnaire Assistance Center
Operational Hours
Day of the Week
Monday:
Tuesday:
Wednesday:
Thursday:
Friday:
Saturday:
Sunday:

Operating Hours

California Complete
Count
Outreach Partner
Questionnaire Assistance Kiosk
Operational Hours
Day of the Week
Monday:
Tuesday:
Wednesday:
Thursday:
Friday:
Saturday:
Sunday:

Operating Hours

California Complete
Count
Outreach Partner
Questionnaire Assistance Center

California Complete
Count
Outreach Partner
Questionnaire Assistance Kiosk

California Complete
Count
Outreach Partner
Questionnaire Assistance Center

California Complete
Count
Outreach Partner
Questionnaire Assistance Kiosk

California Complete
Count
Outreach Partner
Questionnaire Assistance Center

California Complete
Count
Outreach Partner
Questionnaire Assistance Kiosk

California Complete Count
U.S. Census Bureau
In-Language Phone Assistance
English
Spanish
844-330-2020
844-468-202
Chinese (Mandarin)
Chinese (Cantonese)
844-391-2020
844-398-2020
Vietnamese
Korean
844-461-2020
844-392-2020
Russian
Arabic
844-417-2020
844-416-2020
Tagalog
Polish
844-478-2020
844-479-2020
French
Haitian Creole
844-494-2020
844-477-2020
Portuguese
Japanese
844-474-2020
844-460-2020
Telephone Display Device (TDD)
844-467-2020
Note: Individuals do not need a mailer/code to respond via
phone or online.

COUNTY OF SAN LUIS OBISPO
COMPLETE COUNT COMMITTEE

www.slocounty.ca.gov
COUNTY OF SAN LUIS OBISPO

www.slocounty.ca.gov

Ma r k e t in g Up d a t e
So cia l Me d ia Digita l Ma rke tin g
• Ru n Da te s 3/12/20-4/31/20
• Ta rge tin g 3 co re gro u p s
• Mo tio n Gra p h ic Vid e o s

COUNTY OF SAN LUIS OBISPO

www.slocounty.ca.gov

COUNTY OF SAN LUIS OBISPO

www.slocounty.ca.gov

Ma r k e t in g Up d a t e
To o l Kits – 02/26/20
• Fa ct Sh e e ts
• So cia l Me d ia Gra p h ics a n d Ca p tio n s
• Sto ck Im a ge s a n d Ca p tio n s
• Po ste rs
• Ba n n e rs

COUNTY OF SAN LUIS OBISPO

www.slocounty.ca.gov

COUNTY OF SAN LUIS OBISPO

www.slocounty.ca.gov

COUNTY OF SAN LUIS OBISPO

www.slocounty.ca.gov

St o ck Im a g e s
h ttp s://www.d ro p b o x.co m /sh /2d 0gszi7sxx7e k9/AACj38lXEcDy
3AXkDfo MTEb Ba ?d l=0

COUNTY OF SAN LUIS OBISPO

www.slocounty.ca.gov

SLO County Hard-to-Count
Populations
• CFSLOCO has ~$167,000 in funding to regrant to
local nonprofits to reach the HTC populations

Funding Round (Amount)

Amount Awarded

Amount Remaining

Timeline

Ro u n d 1 ($77,268)

$56,004 to 3 gra n te e s

$21,264

Su p p le m e n ta l b u d ge t fo r p rin tin g
m a rke tin g m a te ria ls d u e Fe b . 21

Ro u n d 2 ($90,000): fo cu s o n
se n io r citize n s

An ticip a tin g gra n ts o f
$10,000-$20,000 e a ch

$90,000

Ap p lica tio n d u e to CFSLOCO Fe b . 21;
Awa rd n o tifica tio n Fe b . 28

Ro u n d 3: ($TBD)
TOTAL FUNDING

TBD

Mid -Ap ril/Ma y

~$167,000

COUNTY OF SAN LUIS OBISPO

www.slocounty.ca.gov

Round 1 Grantees

$25,058
•

Ch ild re n a ge d 0-5, lim ite d En glish
la n gu a ge , h o m e le ss, se n io rs, ve te ra n s

•

•

Exte n d e d h o u rs to co m p le te ce n su s a t
11 ce n te rs a cro ss Co u n ty a n d 40 Pra d o ;
wo rk with Pro m o to re s

Ho m e le ss, se n io rs, ve te ra n s, livin g in
ru ra l a re a s, im m igra n ts, p e o p le with
d isa b ilitie s, re n te rs

•

Co m m u n ity sta ke h o ld e r m e e tin gs to
e d u ca te /m o b ilize o th e r o rga n iza tio n s

•

•

•

Tra in e d sta ff will tra in o th e r sta ff;
He a lth Acce ss Tra in e r co n tra cte d b y
First 5 to re a ch fa m ily-se rvin g o rgs
2 Ce n su s Co m p le tio n e ve n ts—on e in
So u th Co u n ty, o n e in Pa so —to h e lp
fa m ilie s co m p le te ce n su s
Ma rke tin g o u tre a ch (n e wsle tte r,
we b site , so cia l m e d ia , e tc.)

$10,000

$20,946

•

8 e ve n ts a t PSHH p ro p e rtie s (d in n e r,
m a te ria ls, co m p u te r a cce ss, a ssista n ce )

•

Ma rke tin g o u tre a ch (n e wsle tte r,
we b site , so cia l m e d ia , e tc.)

•

Atte n d e xistin g e ve n ts h o ste d b y o th e r
o rga n iza tio n s to co n d u ct o u tre a ch

COUNTY OF SAN LUIS OBISPO

•

Ch ild re n a ge d 0-5, lim ite d
En glish la n gu a ge , lim ite d o r n o
In te rn e t a cce ss, ru ra l a re a s,
re n te rs

•

Ou tre a ch to fa m ilie s a n d
su rro u n d in g n e igh b o rh ood s

•

Ma rke tin g o u tre a ch (n e wsle tte r,
we b site , so cia l m e d ia , e tc.)

www.slocounty.ca.gov

Next Steps
• February 21: Supplemental printing budget from Round 1
grantees
due
Round 2 grant applications due

• February 28: Round 2 funding award notification
• Mid-March:

Ongoing events, QAKs up and running

• Mid-April/May:

Round 3 funding based on available Census
completion data

COUNTY OF SAN LUIS OBISPO

www.slocounty.ca.gov

Qu e s t io n n a ir e As s is t a n ce Ce n t e r
• Lo ca tio n : Pa so City Lib ra ry (3201 Sp rin g Stre e t)
• Op e ra tio n a l Tim e lin e : Ma rch 12-Ap ril 25
• Sch e d u le :
• Th u rsd a ys, 2-6 p m
• Frid a ys, 2-5p m
• Sa tu rd a ys, 9:30a m -12:30p m

• Hours Needed:
•
•
•
•

Th u rsd a y, Ma rch 19
Frid a y, Ap ril 10
Th u rsd a y, Ap ril 16
Frid a y, Ap ril 17

COUNTY OF SAN LUIS OBISPO

www.slocounty.ca.gov

Qu e s t io n n a ir e As s is t a n ce Kio s k s
• Eve n ts fro m th e Gro u p

• Ne e d

?

COUNTY OF SAN LUIS OBISPO

www.slocounty.ca.gov

